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Thank You for Choosing Ross
You've made a great choice. We expect you will be very happy with your purchase of Ross Technology. 
Our mission is to:

1. Provide a Superior Customer Experience
• offer the best product quality and support

2. Make Cool Practical Technology

• develop great products that customers love
Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and 
empowers our employees. I hope you enjoy reading it below.
If anything at all with your Ross experience does not live up to your expectations be sure to reach out to 
us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics
Any company is the sum total of the people that make things happen. At Ross, our employees are a 
special group. Our employees truly care about doing a great job and delivering a high quality customer 
experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our 
behavior:

1. We will always act in our customers’ best interest.
2. We will do our best to understand our customers’ requirements.

3. We will not ship crap.
4. We will be great to work with.
5. We will do something extra for our customers, as an apology, when something big goes wrong and 

it's our fault.

6. We will keep our promises.
7. We will treat the competition with respect.
8. We will cooperate with and help other friendly companies.

9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in 
times of company or customer crisis - do what you know in your heart is right. (You may rent 
helicopters if necessary.)
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Important Regulatory and Safety Notices to Service Personnel
Before using this product and any associated equipment, read all the Important Safety Instructions listed below so 
as to avoid personal injury and to prevent product damage.

The OverDrive system makes use of a number of individual component products to make up a complete turnkey 
system. The Important Safety Instructions section of this manual is intended to compliment individual OEM 
product manuals and the User must refer to, and heed, any safety instruction outline in these supplementary product 
manuals. Separate manuals are included for the following component products:

• Server PC(s)
• LCD Flat Screen Display(s) & Power Supply

This system may also require specific equipment, and /or installation procedures be carried out to satisfy certain 
other regulatory compliance requirements. Notices have been included in this publication to call attention to these 
specific requirements.



Symbol Meanings

Protective Earth — This symbol identifies a Protective Earth (PE) terminal, which is provided for 
connection of the supply system’s protective earth (green or green/yellow) conductor.

This symbol on the equipment refers you to important operating and maintenance (servicing) instructions 
within the Product Manual Documentation. Failure to heed this information may present a major risk of 
damage or injury to persons or equipment.

Warning — The symbol with the word “Warning” within the equipment manual indicates a potentially 
hazardous situation which, if not avoided, could result in death or serious injury.

Caution — The symbol with the word “Caution” within the equipment manual indicates a potentially 
hazardous situation which, if not avoided, may result in minor or moderate injury. It may also be used to 
alert against unsafe practices.

Warning Hazardous Voltages — This symbol is intended to alert the user to the presence of 
uninsulated “dangerous voltage” within the product enclosure that may be of sufficient magnitude to 
constitute a risk of shock to persons.

ESD Susceptibility — This symbol is used to alert the user that an electrical or electronic device or 
assembly is susceptible to damage from an ESD event.



Important Safety Instructions
• Read these instructions. 
• Keep these instructions.
• Heed all warning.

• Follow all instructions.

Warning The safe operation of this product requires that a protective earth connection be provided. 
A grounding conductor in the equipment's supply cord provides this protective earth. To 
reduce the risk of electrical shock to the operator and service personnel, this ground 
conductor must be connected to an earthed ground.
Use only power cords specified for this product and certified for the country of use. Refer 
to the Product Power Cord Requirement Section that follows. 
Do not defeat safety purpose of the grounding-type plug. A grounding type plug has two 
blades and a third grounding prong. The third prong is prong is provided for your safety. If 
the provided plug does not fit in to your outlet, consult an electrician for replacement of 
the obsolete outlet.
Protect the power cord from being walked on or pinching particularly at plugs, 
convenience receptacles, and point where they exit from the apparatus.

Warning Indoor Use: “WARNING – TO REDUCE THE RISK OF FIRE OR ELECTRIC SHOCK, 
DO NOT EXPOSE THIS APPARATUS TO RAIN OR MOISTURE”
Do not use this apparatus near water.
Do not block any ventilation openings. Install in accordance with manufacturer’s 
instructions. 
Do not install near heat sources such as radiators, heat registers, stoves, or other apparatus 
(including amplifiers) that produce heat.
Only use attachments/accessories specified by the manufacturer.
Unplug this apparatus during lightning storms or when unused for long periods of time.
Clean only with a dry cloth.

Warning Refer all servicing to qualified personnel. Servicing is required when the apparatus has 
been damaged in any way, such as power-supply cord or plug damage, liquid has been 
spilled or objects have fallen into the apparatus, the apparatus has been exposed to rain or 
moisture, does not operate normally, or has been dropped.

Caution  To reduce the risk of fire, replacement fuses must be the same type and rating.

Warning This product contains safety critical parts, which if incorrectly replaced may present a risk 
of fire or electrical shock. Components contained within the product’s power supplies and 
power supply area, are not intended to be customer serviced and should be returned to the 
factory for repair



Product Power Cord Requirements

EMC Notices
US FCC Part 15

This equipment has been tested and found to comply with the limits for a class A Digital device, pursuant to part 15 
of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the 
equipment is operated in a Commercial environment. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful 
interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful 
interference in which case the user will be required to correct the interference at his own expense.

CANADA

This Class “A” digital apparatus complies with Canadian ICES-003. 

Cet appareil numerique de la classe “A” est conforme a la norme NMB-003 du Canada.

EUROPE

This equipment is in compliance with the essential requirements and other relevant provisions of CE Directive 
93/68/EEC.

INTERNATIONAL

This equipment has been tested to CISPR 22:1997 along with amendments A1:2000 and A2:2002 and found to 
comply with the limits for a Class A Digital device.

Warning North American Line Voltages 100 - 120 Volt 
This product is supplied with certified 10A/125V SVT type supply cords. 
Conductors are color coded white (neutral), black (line) and green or green/yellow 
(ground). 
Operation of this equipment at line voltages exceeding 130V requires that alternative 
supply cords with appropriate voltage and current ratings be used.

Warning International Line Voltages 200 - 240 Volt 
This product has been designed for use with certified IEC 320- C13 10A/250V - H03 
VV-F3G 1.00mm2 type line cord. 
International product orders are supplied with a certified 10A/250V line cords, utilizing a 
molded 3-pin IEC 320-C13 type connector at one end and stripped conductors on the 
other. One line cord is provided. Conductors are CEE color coded; blue (neutral), brown 
(line), and green/yellow (ground). 
Installation by a qualified Electrician, of an appropriately approved A/C wall plug 
certified for the country of use, is required.
Alternatively, other IEC 320 C-13 type power cords may be used, provided that they meet 
the necessary safety certification requirements for the country in which they are to be 
used. Refer to the correctly specified line cord above.

Notice Changes or modifications to this equipment not expressly approved by Ross Video Ltd. could 
void the user’s authority to operate this equipment.

Notice This is a Class A product. In domestic environments, this product may cause radio interference, 
in which case the user may have to take adequate measures.



Warranty and Repair Policy
The OverDrive Live and OverDrive News systems are backed by a comprehensive one-year warranty on all 
components.

If an item becomes defective within the warranty period Ross will repair or replace the defective item, as 
determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the 
customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a temporary loan basis, 
plug in circuit boards or other replacement parts may be supplied free of charge while defective items undergo 
repair. Return packing, shipping, and special handling costs are the responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or application, or 
unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages 
(including loss of profit). Implied warranties, including that of merchantability and fitness for a particular purpose, 
are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of ownership.

Extended Warranty

For customers that require a longer warranty period, Ross offers an extended warranty plan to extend the standard 
warranty period by one year increments. For more information about an extended warranty for your OverDrive 
system, contact your regional sales manager.

Environmental Information
The equipment that you purchased required the extraction and use of natural resources for its production. It may 
contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction 
of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse 
or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health 
conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional 
waste administration.

You can also contact Ross Video for more information on the environmental performances of our products.

Notice — Changes or modifications to this equipment not expressly approved by Ross Video Limited 
could void the user’s authority to operate this equipment.



Use of Hazardous Substances in Electrical and Electronic Products (China RoHS)

Ross Video Limited has reviewed all components and processes for compliance to:

“Management Methods for the Restriction of the Use of Hazardous Substances in Electrical and Electronic 
Products” also known as China RoHS.

The “Environmentally Friendly Use Period” (EFUP) and Hazardous Substance Tables have been established for all 
products. We are currently updating all of our Product Manuals.

The Hazardous substances tables are available on our website at:

http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html 

电器电子产品中有害物质的使用 

Ross Video Limited 按照以下的标准对所有组件和流程进行了审查： 

“电器电子产品有害物质限制使用管理办法”也被称为中国RoHS。 

所有产品都具有“环保使用期限”(EFUP）和有害物质表。目前，我们正在更新我们所有的产品手册。 

有害物质表在我们的网站： 

http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html 

Company Address

Ross Video Limited 
8 John Street
Iroquois, Ontario
Canada, K0E 1K0

Ross Video Incorporated 
P.O. Box 880
Ogdensburg, New York
USA 13669-0880

General Business Office: (+1) 613 • 652 • 4886
Fax: (+1) 613 • 652 • 4425

Technical Support: (+1) 613 • 652 • 4886
After Hours Emergency: (+1) 613 • 349 • 0006

E-mail (Technical Support): techsupport@rossvideo.com
E-mail (General Information): solutions@rossvideo.com

Website: http://www.rossvideo.com

mailto:solutions@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html
http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html
mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
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Introduction
On behalf of our team here at Ross Video, I would like to thank you for choosing to buy a Streamline Play system.

We are committed to providing you with the highest level of customer satisfaction possible. If, for any reason, you 
have questions or comments, please call Ross Video at +1-613-652-4886 or send us an e-mail at 
techsupport@rossvideo.com.

We hope that you visit our website www.rossvideo.com to stay up to date with ongoing software releases, join our 
customer forum and learn more about the complete range of Ross Video products.

Note that software maintenance and extended warranties are available for your system to protect and extend the life 
of your investment. Our sales team are more than happy to provide further information on the plans available. 
Members of our sales team promptly response to e-mails sent to: solutions@rossvideo.com.

Again, thank you for your purchase of a Streamline Play system from Ross Video. We know that you will be very 
pleased with your decision. 

Yours Sincerely,

Peter Abecassis
Director of Product Management - Production Workflow
peter.abecassis@rossvideo.com
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About This Guide
This guide contains the following chapters that cover the configuration and use of Streamline Play software:

1. “Introduction” summarizes the guide and provides important terms, conventions and feature descriptions.

2. “Network Configuration” provides IP address configuration instructions for the Streamline, Streamline 
Server, and Caprica components in your Streamline Play system.

3. “Streamline Configuration” provides configuration instructions for the Streamline media asset manager in 
your Streamline Play system.

4. “Caprica Server Configuration” provides configuration instructions for the Caprica Server in your 
Streamline Play system.

5. “Streamline Server Configuration” provides configuration instructions for the Streamline Server in your 
Streamline Play system.

6. “Inception Configuration” provides configuration instructions for an Inception NRCS to work with your 
Streamline Play system.

7. “Abekas Video Server Configuration” provides configuration instructions for the Abekas video server in 
your Streamline Play system.

If you have questions pertaining to the operation of the Ross Video product, please contact us at the numbers listed 
in the section “Contacting Technical Support” on page 1–3. Our technical staff is always available for 
consultation, training, or service.

Documentation Conventions
Special text formats are used in this guide to identify parts of the user interface, text that a user must enter, or a 
sequence of menus and sub-menus that must be followed to reach a particular command.

Interface Elements
Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For example:

In the Work Order Manager panel, click Create New Work Order.

User Entered Text
Courier text is used to identify text that a user must enter. For example:

In the Language box, enter English.

Referenced Guides
Italic text is used to identify the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the section “Creating a Work Order” in the Streamline Play User Guide.

Menu Sequences
Menu arrows are used in procedures to identify a sequence of menu items that you must follow. For example, if a 
step reads “File > Save As,” you would click the File menu and then click Save As.

Important Instructions
Star icons are used to identify important instructions or features. For example:

When Streamline Play cannot connect to the network, a Message dialog box opens to report the connection 
problem.
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Getting Help
The Ross Video product Online Help system is accessed by selecting Help Topics from the Help menu in the 
product. Alternatively, press the F1 key while working in a client or dialog box.

The Online Help system contains the following navigation tabs to locate information contained in the Online Help 
topics and User Guide:

• Contents — table of contents
• Index — keyword reference
• Search — full text search
• Favorites — preferred information storage and access

Ross Video product guides are also supplied as print-ready PDF files on the Ross Video product Software 
Installation DVD.

Contacting Technical Support
Technical Support is staffed by a team of experienced specialists ready to assist you with any question or technical 
issue.

Ross Video has technical support specialists strategically located around the globe to ensure a prompt response to 
technical inquiries. Our primary technical support center is located in Ottawa, Ontario, Canada. In addition, we 
have offices in The United Kingdom (London), Australia (Sydney), and Singapore with satellite locations in New 
York City, The Netherlands, and China. As we expand our presence globally, we are constantly evaluating other key 
locations to have a local technical support specialist in order to better service our customers.

North America
Our North America center located in Ottawa, Ontario, Canada and is open Monday to Friday 8:30 a.m. to 6:00 p.m. 
EST, with 24/7/365 on-call service after hours.

Our telephone number is: +1-613-686-1557

Toll free within North America: +1 833-859-0499

EMEA
Our EMEA center is open Monday to Friday 8:30 a.m. to 5:00 p.m. GMT. After hours support is provided by our 
North America location.

International toll free: +800 3540 3545

If the local support specialist is not available, your call will be transferred automatically to our North America 
center.

Australia
Our Sydney, Australia office is located in Alexandria, NSW.

Our local support telephone number is: 1300 007 677

If the local support specialist is not available, your call will be transferred automatically to our North America 
center.

Online
E-mail: techsupport@rossvideo.com 

Website: open a support request using the link https://support.rossvideo.com/ to open a support request.

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
https://support.rossvideo.com/
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Network Configuration
This chapter provides IP address configuration instructions for the Streamline, Streamline Server, and Caprica 
components in your Streamline Play system. The following topics are discussed in this chapter:

• Set the Streamline IP Address
• Set the Streamline Server IP Address
• Set the Caprica IP Address
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Set the Streamline IP Address
Streamline runs on the host computer of the Streamline Play system.

• HOST (Streamline) IP address goes on the virtual switch.

Set the Streamline Server IP Address
The Streamline Server runs as a virtual machine on the host computer of the Streamline Play system.

• Use the Hyper-V Manager to access the Streamline Server virtual machine.

Set the Caprica IP Address
Caprica runs as a virtual machine on the host computer of the Streamline Play system.

• Use the Hyper-V Manager to access the Caprica virtual machine.
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Software Licensing Service
Ross Video uses a product key and feature license keys to control user access to Streamline Play features. The Ross 
Licensing Service verifies the your Streamline Play product key and enables access on your Streamline Play system 
to the Streamline Play features your purchased from Ross Video. To verify an Streamline Play product key, the Ross 
Licensing Service uses the internet to communicate with the Ross Video Activation Server. When the Ross 
Licensing Service computer does no have access to the internet, you can upload a verified Streamline Play product 
key from the Ross Offline Licensing Tool that does have internet access.

When an Streamline Play Server computer has multiple active network adapters (wireless, wired, or multiple 
NIC cards), disabling an adapter after licensing Streamline Play software may invalidate your Streamline Play 
product key. To re-license your Streamline Play Server, restart the server and reactivate the product key.

This chapter discusses the following topics:

• Ross Licensing Service Setup
• Ross Licensing Service Software Installation
• Ross Licensing Service Database Software
• Ross Licensing Service Software
• Database Superuser Custom Password
• Activate a Product Key for Streamline Play Software
• Deactivate a Product Key for Streamline Play Software
• View Feature Activations
• Change Your Ross Licensing Service Password
• Backup and Restore Your Ross Licensing Service Database
• Manage Perspectives
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Ross Licensing Service Setup
To license the software for your Streamline Play System you must have a Ross Licensing Service computer as part 
of your system. If your Ross Licensing Service computer falters, a licensed Streamline Play System can continue 
running for up to seven days without out having to connect to the Ross Licensing Service.

The Ross Licensing Service can run on an Streamline Play Server computer in your Streamline Play system or on a 
separate computer. The position of the Ross Licensing Service computer and the software you need to install 
depends on the internet accessibility of your Streamline Play system.

Internet Accessible
When your Streamline Play system has access the internet, the Ross Licensing Service can directly communicate 
with the Ross Video Activation Server.

Figure 3.1  Internet Accessible Streamline Play System

Private Network
When your Streamline Play system can not access the internet, you must use the Ross Offline Licensing Tool to 
communicate over the internet with the Ross Video Activation Server. The Ross Offline Licensing Tool can save a 
verified Streamline Play product key from the Ross Video Activation Server to USB flash drive. You can plug the 
USB flash drive into the Ross Licensing Service computers on your private network to load the verified Streamline 
Play product key to license the software in your Streamline Play system.

Figure 3.2  Private Network Streamline Play System
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Ross Licensing Service Software Installation
The software that you install for the Ross Licensing Service depends on the internet accessibility of your Streamline 
Play system.

Internet Accessible
When your Streamline Play system has access the internet, install the following software on the Ross Licensing 
Service computer in your Streamline Play System:

• Database — refer to the procedure “To install PostgreSQL database software on a Ross Licensing Service 
computer:” on page 3–3

• Ross Licensing Service — refer to the procedure “To install Ross Licensing Service software:” on page 3–9

Private Network
When your Streamline Play system can not access the internet, install the following software on the specified 
computers:

• Ross Licensing Service Computer 
› Database — refer to the procedure “To install PostgreSQL database software on a Ross Licensing Service 

computer:” on page 3–3.
› Ross Licensing Service — refer to the procedure “To install Ross Licensing Service software:” on page 3–9

• Internet Connected Computer 
› Ross Offline Licensing Tool — refer to the procedure 

Ross Licensing Service Database Software
The Ross Licensing Service uses the PostgreSQL database to store and manage licensing data. When you install the 
Ross Licensing Service on the Streamline Play Server computer, you can use the currently installed PostgreSQL 
database to store and mange licensing data. When you install the Ross Licensing Service on a separate computer, 
you must install and configure PostgreSQL database software on the computer before installing the Ross Licensing 
Service software.

 PostgreSQL database software must be installed and configured on the Ross Licensing Service computer before 
you install the Ross Licensing Service software.

Upgrading Ross Licensing Service software to a new version does not require a reinstallation of the PostgreSQL 
database software.

To install PostgreSQL database software on a Ross Licensing Service computer:

1. On a Ross Licensing Service computer, check for the installation of the PostgreSQL database software.

When the PostgreSQL database software is installed on the Ross Licensing Service computer, quit this 
procedure and continue with the procedure “To create the Ross Licensing Service database:” on page 3–8.

2. Exit all currently running Windows® applications.

3. Insert the Streamline Play software DVD into the DVD-ROM drive.

4. On the Desktop, open My Computer.

5. In the My Computer explorer window, open the DVD-ROM Drive.

6. Right-click the postgresql-10.3-3-windows-x64.exe file and select Run as administrator from the Shortcut 
menu.
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The Setup wizard opens.

7. Click Next.

The Installation Directory panel opens.

8. Click Next.

The Select Components panel opens.

9. Click Next.

The Data Directory panel opens.
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10. Replace the folder name in the Data Directory box with the following folder name:

C:\ProgramData\PostgreSQL\10.3\data 

11. Click Next.

The Password panel opens.

12. In the Password box, enter a password for the database super user that meets the password security 
requirements set by your organization. Remember to replace this password for installing, reinstalling, or 
upgrading Ross Licensing Service software.

 For remote support services, Ross Video Technical Support may require your database super user password.

13. In the Retype Password box, type the password you set in step 12.

14. Click Next.

The Port panel opens.

15. Click Next.

The Advanced Options panel opens.

16. Use the Locale list to select [Default locale].

The [Default locale] option sets the PostgreSQL database locale to the same locale set for the Windows 
operating system.
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17. Click Next.

The Pre Installation Summary panel opens.

18. Click Next.

The Ready to Install panel opens.

19. Click Next.

The Installing panel opens. A progress bar displays the installation status. After the installer finishes installing 
the required files, the Completing the PostgreSQL Setup Wizard dialog box opens.

20. Clear the Stack Builder check box.

21. Click Finish.

The Setup wizard closes.

PostgreSQL Database Service User
When you install the Ross Licensing Service on the Streamline Play Server computer, you must set the user that 
runs the PostgreSQL database service before you install Ross Licensing Service software.

When installing the Ross Licensing Service software on the Streamline Play Server computer, do not change the 
user that runs the PostgreSQL database service.
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To set the user that runs the PostgreSQL database service:

1. From the Windows Desktop, press Windows Key+R.

The Run dialog box opens.

2. In the Open box, type the following application name:

services.msc 

3. Click OK.

The Services window opens.

4. In the Services list, locate the postgresql-x64-10 service.

5. Right-click the postgresql-x64-10 service and select Properties from the shortcut menu.

The postgresql-x64-10 Properties dialog box opens.

6. Click the Log On tab.

The Log On tab opens.
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7. Select the Local System Account option.

8. Click OK.

The Services alert dialog box opens.

9. In the Services alert, click OK.

The Services alert and the postgresql-x64-10 Properties dialog box close.

10. In the Services window, click Restart for the postgresql-x64-10 service.

11. Use the File menu to select Exit.

The Services window closes.

Ross Licensing Service Database
You must create a Postgres database named “licensing_service” before you install Ross Licensing Service software.

To create the Ross Licensing Service database:

1. From the Windows Desktop, use the Start menu to select All Programs > PostgreSQL 10 > pgAdmin 4.

The pgAdmin 4 web page opens.

2. In the Browser tree view, expand the Servers node.

The Browser tree view displays the available Postgres servers.

3. Right-click the PostgreSQL 10 server and select Connect Server from the shortcut menu.

The Connect to Server dialog box opens.
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4. In the Password box, enter the custom password set during installation of the Ross Licensing Service database 
software on the Ross Licensing Service computer.

5. Click OK.

The PostgreSQL 10 node expands in the Object Browser tree view.

6. In the expanded PostgreSQL 10 node, right-click the Databases node and select Create > Database from the 
shortcut menu.

The Create - Database dialog box opens.

7. In the Database box, type the following name:

licensing_service 

8. Click OK.

PostgreSQL adds the licensing_service database to the Databases node in the Browser tree view and the 
Properties tab of the pgAdmin 4 web page.

9. Close the web browser.

The pgAdmin 4 web page closes.

Ross Licensing Service Software
After installing and configuring the PostgreSQL database software on the Ross Licensing Service computer, you 
can install the Ross Licensing Service software on the computer.

To install Ross Licensing Service software:

1. On the Ross Licensing Service computer, exit all currently running Windows® applications.

2. Temporarily disable antivirus software running on the Ross Licensing Service computer.

Some heuristic-based intrusion detection systems prevent the installation of Ross Licensing Service software.

1. Insert the Streamline Play software DVD into the DVD-ROM drive.

2. On the desktop, open My Computer.

3. In the My Computer explorer window, open the DVD-ROM Drive.
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4. Double-click the LicensingService-X.X.X.X-####.msi file.

The Ross Licensing Service Setup wizard opens

5. Click Next.

The End-User License Agreement screen opens.

6. Read the Ross Licensing Service Software License Grant.

7. Select the I accept the terms of the License Agreement option to install Ross Licensing Service software.

8. Click Next.

The Choose Setup Type screen opens.

9. Click the Ross Licensing Service icon.

The Ready to Install screen opens.
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10. Click Install.

After installation of the Ross Licensing Service is complete, the Installation Complete screen opens.

11. Click Finish.

The Ross Licensing Service Setup wizard closes and adds the following icons to the Desktop:

• Ross Licensing Service Readme 
• Ross Licensing Service Release Notes 
• Ross Licensing Service 

The Ross Licensing Service starts automatically after the installation of the Ross Licensing Service software.

12. Re-enable antivirus software.

13. Continue with one of the following:

• If your Ross Licensing Service database uses the standard password for the database superuser postgres, 
skip to the section “Activate a Product Key for Streamline Play Software” on page 3–13.

• If your Ross Licensing Service database does not use the standard password the database superuser 
postgres, complete the procedure in the section “Database Superuser Custom Password” on page 3–11.

Database Superuser Custom Password
During the installation of the PostgreSQL database, you must set the password for the database superuser and 
service account named postgres. If the password set for postgres is not the standard password, the installer 
must configure Ross Licensing Service software to use the set custom password.

To set a custom postgres password:

1. Use one of the following methods to open the Ross Licensing Service web page:

• On the Desktop, double-click the Ross Licensing Service icon.
• Use the Start menu to select All Programs > Ross Licensing Service > Ross Licensing Service.

The Ross Licensing Service Login screen opens. If the Ross Licensing Service Login screen does not open, 
please contact Ross Video Technical Support.

2. At the Ross Licensing Service Login screen, enter the following user name and password in the provided 
boxes:

• Username — maintenance 
• Password — <maintenance_password> 

3. Click Login.

The Ross Licensing Service web page opens.
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4. In the Tools section of the main toolbar, click the  Configuration icon.

The System Monitor panel of the Configuration window opens.

5. On the Configuration window toolbar, click the  System icon.

The System panel opens.

6. In the Password box of the Database tab, enter the custom password set for the database superuser named 
postgres.

7. Click OK.

An Alert dialog box opens.

8. In the Alert dialog box, click OK.

The Alert and Configuration dialog boxes close.

9. On the main toolbar, click the  Logout icon.

A Message dialog box opens.

10. In the Message dialog box, click OK to log out of the Ross Licensing Service.

11. Close the web browser.

12. From the Windows Desktop, press Windows Key+R.

The Run dialog box opens.
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13. In the Open box, type the following application name:

services.msc 

14. Click OK.

The Services window opens.

15. In the Services list, locate and select the Ross Licensing Service service.

16. Click Restart for the Ross Licensing Service service.

17. Use the File menu to select Exit.

The Services dialog box closes.

Activate a Product Key for Streamline Play Software
Ross Video uses product keys to manage user licenses for Streamline Play features. You can obtain an Streamline 
Play product key from Ross Video Technical Support.

When you activate an Streamline Play product key, your Ross Licensing Service computer must contact the Ross 
Video Activation Server through the internet.

When you reactivate an Streamline Play product key after adding feature licenses to the key, you must restart 
your Streamline Play System.

Depending on the internet connectivity of your Streamline Play system, complete the procedures in one of the 
following sections to activate your product key:

• “Internet Accessible” on page 3–13
• “Private Network” on page 3–15

Internet Accessible
When your Streamline Play system has access the internet, the Ross Licensing Service can directly communicate 
with the Ross Video Activation Server to active your Streamline Play product key and license Streamline Play 
software.

To activate an Streamline Play product key for an Streamline Play system connected to the internet:

1. Verify that the Ross Licensing Service computer can connect to the Internet.

2. Verify that you have an Streamline Play product key for your Streamline Play System. If you do not have an 
Streamline Play product key, contact Ross Video Technical Support to obtain an Streamline Play product key.
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3. On the Desktop of the Ross Licensing Service computer, double-click the Ross Licensing Service icon.

The Ross Licensing Service Login screen opens.

 If the Ross Licensing Service web page does not open, please contact Ross Video Technical Support.

4. At the Ross Licensing Service Login screen, enter the following user name and password in the provided 
boxes:

• Username — root 
• Password — <your_password> 

5. Click Login.

The Ross Licensing Service web page opens.

 If a message displays indicating that the system is in maintenance mode, the Ross Licensing Service cannot 
communication with the database. Please contact Ross Video support.

6. In the Licensing section of the main toolbar, click the  Activate License icon.

The Licensing Configuration dialog box opens.

7. In the Product Key box, enter the Streamline Play product key obtained from Ross Video Technical Support.

8. In the Product Version box, enter the version number (#.#) of your Streamline Play Server software.

9. Click Activate.

After activating the entered Streamline Play product key, an Alert dialog box opens requesting a web browser 
window refresh.

10. Click OK.

11. In the Licensing section of the Ross Licensing Service toolbar, click the  List License icon.

The Licenses panel opens listing the active licenses.
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12. To view the features contained in an Streamline Play product key, double-click the product key in the Key 
column.

The Product Key panel opens listing the feature licenses contained in the selected product key.

13. Use the following procedures to use the activated Streamline Play product key to license the Caprica Server 
and Streamline Play Server in your Streamline Play system:

• Caprica Server — “License Caprica Server Software” on page 4–2
• Streamline Server — “License Streamline Server Software” on page 5–2

Private Network
When your Streamline Play system cannot access the internet, you must use the Ross Offline Licensing Tool to 
communicate over the internet with the Ross Video Activation Server.

Ross Offline Licensing Tool Software Install

Before you can license an Streamline Play system that cannot access the internet, you must install the Ross Offline 
Licensing Tool on a computer that can communicate over the internet with the Ross Video Activation Server.

To install the Ross Offline Licensing Tool:

1. Connect a USB Flash Drive to the Ross Licensing Service computer.

2. On the Desktop of the Ross Licensing Service computer, double-click the Ross Licensing Service icon.

The Ross Licensing Service Login screen opens.

3. At the Ross Licensing Service Login screen, enter the following user name and password in the provided 
boxes to log in as an Administrator:

• Username — root 
• Password — <your_password> 

4. Click Login.

The Ross Licensing Service web page opens.

 If the Ross Licensing Service web page does not open, please contact Ross Video Technical Support.
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5. In the Tools section of the main toolbar, click the  Download Ross Offline Licensing Tool icon.

6. Save the offline-licensing-tool.msi installer file to a USB Flash Drive.

7. Connect the USB Flash Drive to a computer that can communicate over the internet with the Ross Video 
Activation Server.

8. On the USB Flash Drive, double-click the offline-licensing-tool.msi installer file.

The Ross Offline Licensing Tool Setup wizard opens

9. Click Next.

The Select Installation Folder screen opens.

10. Click Next.

The Ready to Install screen opens.

11. Click Install.

After installation of the Ross Licensing Service is complete, the Installation Complete screen opens.

12. Click Finish.

The Ross Licensing Service Setup wizard closes.
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License an Streamline Play System on a Private Network

After you install the Ross Offline Licensing Tool on a computer that can communicate with the Ross Activation 
Server, your are ready to activate an Streamline Play product key for your Streamline Play System.

 You must generate an activation file from each Ross Licensing Service computer in your Streamline Play system 
and active the matching license file for each Ross Licensing Service.

To activate an Streamline Play product key for an Streamline Play system on a private network:

1. Verify that you have an Streamline Play product key for your Streamline Play System. If you do not have an 
Streamline Play product key, contact Ross Video Technical Support to obtain an Streamline Play product key.

2. Connect a USB Flash Drive to the Ross Licensing Service computer.

3. On the Desktop of a Ross Licensing Service computer, double-click the Ross Licensing Service icon.

The Ross Licensing Service Login screen opens.

4. At the Ross Licensing Service Login screen, enter the following user name and password in the provided 
boxes to log in as an Administrator:

• Username — root 
• Password — <your_password> 

5. Click Login.

The Ross Licensing Service web page opens.

6. In the Licensing section of the main toolbar, click the  Activate License icon.

The Licensing Configuration dialog box opens.

7. In the Product Key box, enter the Streamline Play product key obtained from Ross Video Technical Support.

8. In the Product Version box, enter the version number (#.#) of your Streamline Play Server software.

9. Click Save Activation Information.

The Licensing Configuration dialog box closes and the Ross Licensing Service saves a license.activation file 
to your Downloads folder.

10. Copy the license.activation file from your Downloads folder to the USB Flash Drive connected to the Ross 
Licensing Service computer.
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11. Disconnect the USB Flash Drive from the Ross Licensing Service computer.

12. Connect the USB Flash Drive to the computer that you installed the Ross Offline Licensing Tool.

13. On the Desktop of the Ross Offline Licensing Tool computer, double-click the Ross Offline Licensing Tool 
icon.

The Ross Offline Activation Tool opens.

14. In the Ross Offline Activation Tool, click Upload Activation info.

The Open dialog box opens.

15. Use the Open dialog box to select the Locate and open the license.activation file to the USB Flash Drive.

16. Click Open.

The Ross Offline Activation Tool displays the Product Key, Hardware Unique ID, and Software Version 
contained in the selected license.activation file.

17. Click Activate.

The Specify a file to save license file dialog box opens.

18. Select the USB Flash Drive as the location to save the license file.

19. In the File Name box, enter a file name for the license file.

20. Click Save.

The Ross Offline Activation Tool saves a license file for the Ross Licensing Service to the USB Flash Drive.

21. Disconnect the USB Flash Drive from the Ross Offline Licensing Tool computer.

22. Connect the USB Flash Drive to the Ross Licensing Service computer.

23. In the Ross Licensing Service, click the  Browse for License File icon in the Licensing section of the main 
toolbar.

The Upload Licensing File dialog box opens.

24. Click Browse.

The File Upload dialog box opens.

25. Use the File Upload dialog box to select your license file from the connected USB Flash Drive.
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26. Click Open.

The File Upload dialog box closes and the Upload Licensing File dialog box displays the name of the selected 
license file.

27. Click Upload.

After uploading the selected license file, an Alert dialog box opens reporting a successful upload.

28. Click OK.

The Alert and Upload Licensing File dialog boxes close.

29. In the Licensing section of the Ross Licensing Service toolbar, click the  List License icon.

The Licenses panel opens listing the active licenses.

30. To view the features contained in an Streamline Play Product key, double-click the product key in the Key 
column.

The Product Key panel opens listing the feature licenses contained in the selected product key.

31. Use the following procedures to use the activated Streamline Play product key to license the Caprica Server 
and Streamline Play Server in your Streamline Play system:

• Caprica Server — “License Caprica Server Software” on page 4–2
• Streamline Server — “License Streamline Server Software” on page 5–2

Deactivate a Product Key for Streamline Play Software
Before you can start the following Streamline Play system changes or upgrades you must deactivate your currently 
active Streamline Play product key:

• Move the Ross Licensing Service from one computer to another computer.
• Add Streamline Play features to your product key
• Upgrade Streamline Play Server software to a new version.

After deactivation, you can change or upgrade your Streamline Play system. After you complete your Streamline 
Play system changes or upgrades, you must once again activate your Streamline Play product license to use your 
Streamline Play system.

For More Information on...
• activating an Streamline Play product key for an internet connected Streamline Play system, refer to the 

procedure “To activate an Streamline Play product key for an Streamline Play system connected to the 
internet:” on page 3–13

• activating an Streamline Play product key for and Streamline Play system on a private network, refer to the 
procedure “To activate an Streamline Play product key for an Streamline Play system on a private 
network:” on page 3–17
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Internet Accessible
When your Streamline Play system has access the internet, the Ross Licensing Service can directly communicate 
with the Ross Video Activation Server to deactivate the product key for your Streamline Play software.

To deactivate an Streamline Play product key for an Streamline Play system connected to the internet:

1. On the Desktop of a Ross Licensing Service computer, double-click the Ross Licensing Service icon.

The Ross Licensing Service Login screen opens.

2. At the Ross Licensing Service Login screen, enter the following user name and password in the provided 
boxes to log in as an Administrator:

• Username — root 
• Password — <your_password> 

3. Click Login.

The Ross Licensing Service web page opens.

4. In the Licensing section of the main toolbar, click the  List License icon.

The Licenses panel opens listing the active licenses.

5. In the Key column, double-click the Streamline Play product key to deactivate.

The Product Key panel opens listing the feature licenses contained in the selected product key.

6. In the Product Key panel toolbar, click the  Deactivate icon.

After deactivating the selected Streamline Play product key, an Alert dialog box opens reporting a successful 
deactivation.

7. Click OK.

The Alert dialog box and the Product Key panel close. The Ross Licensing Service also removes the 
Streamline Play product key from the Licenses panel.
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Private Network
When your Streamline Play system cannot access the internet, you must use the Ross Offline Licensing Tool to 
communicate over the internet with the Ross Video Activation Server to deactivate a product key.

To deactivate an Streamline Play product key for an Streamline Play system on a private network:

1. Connect a USB Flash Drive to the Ross Licensing Service computer.

2. On the Desktop of the Ross Licensing Service computer, double-click the Ross Licensing Service icon.

The Ross Licensing Service Login screen opens.

 If the Ross Licensing Service web page does not open, please contact Ross Video Technical Support.

3. At the Ross Licensing Service Login screen, enter the following user name and password in the provided 
boxes:

• Username — root 
• Password — <your_password> 

4. Click Login.

The Ross Licensing Service web page opens.

 If a message displays indicating that the system is in maintenance mode, the Ross Licensing Service cannot 
communication with the database. Please contact Ross Video support.

5. In the Licensing section of the main toolbar, click the  List License icon.

The Licenses panel opens listing the active licenses.

6. In the Key column, double-click the Streamline Play product key to deactivate.

The Product Key panel opens listing the feature licenses contained in the selected product key.
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7. In the Product Key panel toolbar, click the  Download Deactivate / Reactivation file icon.

The Deactivate / Reactivation dialog box opens.

8. When deactivating an Streamline Play product key as part of an upgrade from one version of Streamline Play 
Server software to the next version, complete the following steps:

a. Select the Software Upgrade check box.

The Version box opens.

b. In the New Product Version box, enter the version number (#.#) of the Streamline Play Server software to 
which you are upgrading.

9. Click Download File.

The Deactivate / Reactivation dialog box closes and the Ross Licensing Service saves a license.activation 
file to your Downloads folder.

10. Copy the license.activation file from your Downloads folder to the USB Flash Drive connected to the Ross 
Licensing Service computer.

11. Disconnect the USB Flash Drive from the Ross Licensing Service computer.

12. Connect the USB Flash Drive to the computer that you installed the Ross Offline Licensing Tool.

13. On the Desktop of the Ross Offline Licensing Tool computer, double-click the Ross Offline Licensing Tool 
icon.

The Ross Offline Activation Tool opens.

14. In the Ross Offline Activation Tool, click Browse for Activation info.

The Open dialog box opens.

15. Use the Open dialog box to locate and select the license.activation file to the USB Flash Drive.

16. Click Open.

The Ross Offline Activation Tool displays the Product Key, Hardware Unique ID, and Software Version 
contained in the selected license.activation file.
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17. Click Deactivate.

After deactivating the selected product key, an Alert dialog box opens reporting a successful deactivation.

18. Click OK.

The Alert dialog box closes. The Ross Licensing Service also removes the product key from the Licenses 
panel.

View Feature Activations
For each feature listed in the Product Key panel you can view the current number of activations of the feature.

To view the activations of a feature:

1. Log in to the Ross Licensing Service web page.

2. In the Licensing section of the main toolbar, click the  List License icon.

The Licenses panel opens listing the active licenses.

3. To view the features contained in an Streamline Play Product key, double-click the product key in the Key 
column.

The Product Key panel opens listing the feature licenses contained in the selected product key.

4. In the Feature Name column, double-click the name of the feature for which to view activations.

The Feature Activation List panel opens for the selected feature.

Each row in the Feature Activation List displays the following information:

• Feature ID — feature identification number
• Hardware ID — identification number of the computer using the feature
• Licenses Key — the license key that contains the feature
• IP Address — IP address of the computer using the feature
• Last Used — the last date and time that the feature was active

5. To close the Feature Activation List panel, click the  Close icon in the top right corner of the panel.
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Change Your Ross Licensing Service Password
While working with the Ross Licensing Service, you can change the password used by the root user to log in to the 
Ross Licensing Service.

To change the root user password for the Ross Licensing Service:

1. Log in to the Ross Licensing Service.

2. On the main toolbar, click the  Change Password icon.

The Change Password dialog box opens.

3. In the Old Password box, enter the root user current password.

4. In the New Password box, enter a new password for the root user.

5. In the Verify Password box, re-enter the new password for the root user.

6. Click Change Password.

A message informs you of the successful change of your password.

7. Click OK.

The next time you log in to the Ross Licensing Service, use the new password you set for the root user account.

Backup and Restore Your Ross Licensing Service Database
The Ross Licensing Service uses the PostgreSQL database store licensing data in a database named 
“licensing_service”. The PostgreSQL pgAdmin program enables you to backup the Ross Licensing Service 
database to a file. The pgAdmin program creates a .backup file that you can use to restore to the Ross Licensing 
Service database.

Backup a Ross Licensing Service Database
You should only backup the Ross Licensing Service database when there are no Streamline Play users working on 
the Streamline Play system. Complete the following procedures to backup your Ross Licensing Service database:

• Stop the Ross Licensing Service, “To stop the Ross Licensing Service” on page 3–25.
• Backup the Ross Licensing Service database.

› PostgreSQL 10.3 — “To backup a PostgreSQL 10.3 Ross Licensing Service database” on page 3–26.
› PostgreSQL 9.3 — “To stop the Ross Licensing Service” on page 3–25.

• Start the Ross Licensing Service, “To start the Ross Licensing Service” on page 3–29.
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Stop the Ross Licensing Service

Before you backup up the Ross Licensing Service database you must stop the Ross Licensing Service.

To stop the Ross Licensing Service

1. From the Windows Desktop, press Windows Key+R.

The Run dialog box opens.

2. In the Open box, type the following application name:

services.msc 

3. Click OK.

The Services window opens.

4. In the Services list, locate and select the Ross Licensing Service service.

5. Click Stop for the Ross Licensing Service service.

PostgreSQL 10.3 Ross Licensing Service Database Backup

When the Ross Licensing Service uses the PostreSQL 10.3 database to store the Ross Licensing Service database, 
you use the pgAdmin 4 program to backup the database.
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To backup a PostgreSQL 10.3 Ross Licensing Service database

1. From the Windows Desktop, use the Start menu to select All Programs > PostgreSQL 10 > pgAdmin 4.

The pgAdmin 4 web page opens.

2. In the Browser tree view, expand the Servers node.

The Browser tree view displays the available Postgres servers.

3. Right-click the PostgreSQL 10 server and select Connect Server from the shortcut menu.

The Connect to Server dialog box opens.

4. In the Password box, enter the custom password set during installation of the Ross Licensing Service database 
software on the Ross Licensing Service computer.

5. Click OK.

The PostgreSQL 10 node expands in the Object Browser tree view.

6. In the tree view, expand Databases node.
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7. In the expanded Databases node, right-click the licensing_service node and select Backup from the shortcut 
menu.

The Backup database dialog box opens.

8. In the File name box enter a name for the backup file with the file extension .backup. for example:

licensing_service-09_05_2018.backup 

9. Click Backup.

The Backup Database dialog box closes. The following alert opens after the successful backup of the Ross 
Licensing Service database:

10. Close the alert and web browser.

The pgAdmin 4 web page closes.

PostgreSQL 9.3 Ross Licensing Service Database Backup

When the Ross Licensing Service uses the PostreSQL 9.3 database to store the Ross Licensing Service database, 
you use the pgAdmin III program to backup the database.

To backup a PostgreSQL 9.3 Ross Licensing Service database

1. From the Windows Desktop, use the Start menu to select All Programs > PostgreSQL 9.3 > pgAdmin III.

The pgAdmin III window opens.
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2. In the Object Browser tree view, right-click the PostgreSQL 9.3 (localhost:5432) database and select 
Connect from the shortcut menu.

The Connect to Server dialog box opens.

3. In the Password box, enter the custom password set during installation of the Inception Server software on the 
Inception Server computer.

4. Click OK.

The PostgreSQL 9.3 node expands in the Object Browser tree view.

5. In the tree view, expand Databases node.

6. In the expanded Databases node, right-click the licensing_service node and select Backup from the shortcut 
menu.

The Backup database dialog box opens.

7. Click Browse (...) to the right of the Filename box.

The Select backup filename dialog box opens.

8. Use the Select backup filename dialog box to select a folder to save the database .backup file.

9. In the File name box enter a name for the .backup file.

10. Click Save.

The Select backup filename dialog box closes.

11. In the Backup database dialog box, click Backup.

12. When the Backup database dialog box displays the message Process returned exit code 0, click 
Done.

The Backup database dialog box closes.

13. In the pgAdmin III window, use the File menu to select Exit.

The pgAdmin III window closes.
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Start the Ross Licensing Service

After you backup up the Ross Licensing Service database you must start the Ross Licensing Service.

To start the Ross Licensing Service

1. From the Windows Desktop, press Windows Key+R.

The Run dialog box opens.

2. In the Open box, type the following application name:

services.msc 

3. Click OK.

The Services window opens.

4. In the Services list, locate and select the Ross Licensing Service service.

5. Click Start for the Ross Licensing Service service.

6. Use the File menu to select Exit.

The Services window closes.

Restore the Ross Licensing Service Database from a Backup
You can use a .backup file to restore the database used by the Ross Licensing Service. You should only backup the 
Ross Licensing Service database when there are no Streamline Play users working on the Streamline Play system.

To Restore the Ross Licensing Service database

1. Stop the Ross Licensing Service.

For more information, refer to the procedure “To stop the Ross Licensing Service” on page 3–25.

2. From the Windows Desktop, use the Start menu to select All Programs > PostgreSQL 10 > pgAdmin 4.

The pgAdmin 4 web page opens.

3. In the Browser tree view, expand the Servers node.

The Browser tree view displays the available Postgres servers.

4. Right-click the PostgreSQL 10 server and select Connect Server from the shortcut menu.

The Connect to Server dialog box opens.

5. In the Password box, enter the custom password set during installation of the Ross Licensing Service database 
software on the Ross Licensing Service computer.

6. Click OK.

The PostgreSQL 10 node expands in the Object Browser tree view.

7. In the tree view, expand Databases node.
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8. In the expanded Databases node, right-click the licensing_service node and select Restore from the shortcut 
menu.

The Restore Database dialog box opens.

9. Click Browse (...) to the right of the Filename box.

The Select file dialog box opens.

10. Use the Select file dialog box to select .backup file with which to restore the Ross Licensing Service database.

11. Click Select.

The Select file dialog box closes.

12. In the Restore Database dialog box, click the Restore options tab.

The Restore options tab opens.

13. In the Queries section, click the Clean before restore option to change the option to Yes.

14.  click Restore.

The Restore Database dialog box closes. The following alert opens after the successful restore of the Ross 
Licensing Service database:

15. Close the alert and web browser.

The pgAdmin 4 web page closes.

16. Start the Ross Licensing Service.

For more information, refer to the procedure “To start the Ross Licensing Service” on page 3–29.
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Manage Perspectives
A user perspective is a customized view of the Ross Licensing Service user interface. It is a mapping of Ross 
Licensing Service panel types to positions in the user interface layout. Perspectives also save the columns displayed 
in the Licenses and Product Key panels. Perspectives are not available on mobile devices.

For example, you can create a perspective that includes the Licenses panel in the left column and a Product Key 
panel in the right column. When you use this perspective, any Product Key panels that you open display in the right 
column. Perspectives can include following panels:

• Licenses (Including panel columns)
• Product Key (Including panel columns)

All Ross Licensing Service users can create perspectives for their own use. Ross Licensing Service administrators 
can also create global perspectives available to all users.

 Panels may not always open exactly where you expect. As you open and close panels, Ross Licensing Service 
adjusts the layout to optimize use of the available space.

Create a New Perspective
To create a new perspective for your own use

1. Log in to the Ross Licensing Service web page as a system administrator.

2. Open one of each type of panel you want to include in the new perspective.

3. Use the following procedure to move the panels to the positions you want them to occupy in the perspective:

a. At the top of the panel you want to move, click and drag the panel name tab.

The layout guide opens.

b. Drag the pointer over the layout guide to specify the position to which you want to move the panel.

As you drag the pointer over the layout guide, the current drop position for the panel turns yellow. Light 
gray indicates unoccupied positions. Dark gray indicates occupied positions that can accept additional 
panels.

c. When the position to which you want to move the panel turns yellow, release the mouse button.
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4. Use the following procedure to display the Licenses or Product Key panel columns to include in the 
perspective:

a. In a Licenses or Product Key panel, right-click the title of any table column.

The Columns list opens for the selected panel.

b. Select Licenses or Product Key panel columns as follows:

• To include a column, select the check box to the left of the column name.
• To remove a column, clear the check box to the left of the column name.

c. Select the Force fit columns check box to automatically resize column widths to the table content.

d. Click Close.

e. Click and drag columns to reposition columns in the panel.

f. Click and drag column dividers to manually resize the width of individual columns.

5. On the main toolbar, point to the  Perspectives icon.

A list of saved perspectives opens.

6. In the list, click Manage Perspectives.

The Configuration window opens, showing the Perspectives tab.

Licenses Product Key
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7. Click Save As.

The Save Perspective As page opens.

8. In the Name box, enter a name for the new perspective.

9. Click Save.

The Save Perspective As page closes and the Ross Licensing Service adds the new perspective to the 
Perspectives list.

10. Click OK to close the Configuration window.

Open a Saved Perspective
To open a saved perspective

1. On the main toolbar, point to the  Perspectives icon.

A list of saved perspectives opens. The last item on the list, Manage Perspectives, is not a perspective.

2. In the list, click the perspective to open.

The Ross Licensing Service repositions the open panels to conform to the layout in the selected perspective.

Rename a Perspective
To rename a perspective

1. On the main toolbar, point to the  Perspectives icon to select Manage Perspectives from the list.

The Configuration window opens, showing the Perspectives tab.

2. In the Perspectives list, select the perspective to rename.
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3. Click Rename.

The Rename Perspective page opens.

4. In the Name box, enter a new name for the selected perspective.

5. Click Save.

The name of the perspective updates in the Perspectives list.

6. Click OK to close the Configuration window.

Change the Layout of a Perspective
To change the layout of a perspective

1. Rearrange the panels in a perspective to form the new layout for the perspective.

2. In a Licenses or Product Key panel, display the panel columns to include in the perspective.

3. On the main toolbar, use the  Perspectives icon to select Manage Perspectives from the list.

The Configuration window opens, showing the Perspectives tab.

4. In the Perspective list, select the perspective for the new panel layout.

5. Click Save.

A confirmation message opens, asking whether you want to overwrite the perspective.

6. In the confirmation message, click OK.

The confirmation message closes and the Ross Licensing Service saves the set panel layout is with the selected 
perspective.

7. Click OK to close the Configuration window.

Revert a Perspective to the Default Layout
When you first use the Ross Licensing Service, it opens certain types of panels in certain panel positions by default. 
The Ross Licensing Service continues to use the default layout until you move a panels or open a saved perspective.

You can revert a saved perspective to the Ross Licensing Service default layout. This is useful if you want to make 
the default layout permanently available as a perspective, or if you want to use it as a starting point for creating a 
new customized perspective. When a user reverts to the default layout, the Ross Licensing Service also reverts the 
columns displayed in the Licenses and Product Key panels to their default columns.
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The following illustration describes the default layout.

Figure 3.3  Default Panel Layout

Default layout positions are as follows:

• Grid-based panels open in the top middle box.
• Editor panels open in the bottom left box.
• The Video Player panel opens in the bottom right box.
• Feed-based panels open in the right column.

By default, the Ross Licensing Service does not occupy all eight positions with a panel. the Ross Licensing Service 
does optimize a layout by expanding open panels to fill all available space. When you use the default layout and 
open instances of every type of panel, panels display as follows:

Figure 3.4  Actual Layout with all Panel Types Open

To revert a perspective to the default layout

1. On the main toolbar, use the  Perspectives icon to select Manage Perspectives from the list.

The Configuration window opens, showing the Perspectives tab.

2. In the Perspective list, select the perspective to apply the default layout.

3. Click or tap Revert to Default.

A confirmation message opens, asking whether you want to revert the perspective to the default layout.

 There is no undo for this change. When you revert to the default layout, the Ross Licensing Service also reverts 
the columns displayed in the Licenses and Product Key panels to their default columns. Click or tap Cancel to 
keep the current perspective layout.
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4. In the confirmation message, click or tap OK.

The confirmation message closes and the Ross Licensing Service saves the default panel layout with the 
selected perspective.

5. Click OK to close the Configuration window.

Make a User Perspective Global
A user-specific perspective is only available to the Ross Licensing Service user who created it. Global perspectives 
are available to all Ross Licensing Service users. If you are a Ross Licensing Service administrator, you can make a 
user-specific perspective global.

To make a user-specific perspective global

1. Log in to the Ross Licensing Service web page as a system administrator.

Only administrators can make a perspective available to all users.

2. On the main toolbar, the  Perspectives icon to select Manage Perspectives from the list.

The Configuration window opens, showing the Perspectives tab.

3. In the Perspectives list, select the user-specific perspective to make available to all users.

Perspectives that do not have a check mark in the Global column of the Perspectives list are user-specific and 
only available to the users that created them. A check mark in the Global column of the Perspectives list 
indicates that a perspective is global and available to all users.

4. Click Set as Global. This option is only available to Ross Licensing Service administrators.

A check mark displays in the Global column of the selected perspective, which indicates that all users now 
have access the perspective from the  Perspectives icon.

5. Click OK to close the Configuration window.

To make a global perspective user-specific

1. As an administrator, use the  Perspectives icon to select Manage Perspectives from the list.

The Configuration window opens, showing the Perspectives tab.

2. In the Perspectives list, select the global perspective to make user-specific.

A check mark in the Global column of the Perspectives list indicates that a perspective is global and available 
to all users. Perspectives that do not have a check mark are user-specific.

3. Click Set as User. This option is only available to Ross Licensing Service administrators.

The Ross Licensing Service removes the check mark from the Global column of the selected perspective, 
which indicates that only the user who created the perspective can use it.

4. Click OK to close the Configuration window.

Delete a Perspective
Ross Licensing Service users can only delete perspectives that they created. You must log in to the Ross Licensing 
Service as an administrator to delete global perspectives.

To delete a perspective

1. On the main toolbar, use the  Perspectives icon to select Manage Perspectives from the list.

The Configuration window opens, showing the Perspectives tab.

2. In the Perspectives list, select the perspective to delete.
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3. Click or tap Delete.

A confirmation message opens, asking whether you want to delete the perspective. Click or tap Cancel to keep 
the perspective.

4. In the confirmation message, click OK.

The Ross Licensing Service deletes the selected perspective from the Perspectives list.

5. Click OK to close the Configuration window.
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Caprica Server Configuration
This chapter provides configuration instructions for the Caprica Server in your Streamline Play system. The 
following topics are discussed in this chapter:

• License Caprica Server Software
• Import Caprica Configuration
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License Caprica Server Software
Ross Video uses a product key and feature license keys to control user access to the Caprica Server. The Ross 
Licensing Service verifies the your Streamline Play product key and enables you to access the Caprica Server.

 Before you can license the Caprica Server, your must activate your Streamline Play product key on the Ross 
Licensing Service in your Streamline Play system. Refer to the section “Activate a Product Key for Streamline 
Play Software” on page 3–13 for information on activating Streamline Play product keys.

You can obtain a Streamline Play product key from Ross Video Technical Support.

To license a Caprica Server

1. Use a web browser to open the Caprica web page URL. The format of the URL is as follows, where
<Caprica Server> is the hostname or IP address of your Caprica Server computer:

https://<Caprica Server>:9090 

If the web browser identifies your connection with the Caprica web page as not secure, add an exception for the 
Caprica web page.

 If the Caprica web page does not open, your Caprica Server computer is not running the CentOS 7 operating 
system. Contact Ross Video Technical Support to upgrade the operating system of your Caprica Server 
computer.

The Caprica Login web page opens.

2. Use the following credentials to log in to the Caprica web page:

• User: caprica 
• Password: <you_password> 

3. Click Log In.

The Caprica web page opens.
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4. In the tree view, click License.

The License web page opens.

5. In the License section, enter the IP address or hostname of your Ross Licensing Service computer in the 
License Server Address box.

6. In the License Server Port box, enter the network port number of Ross Licensing Service.

Port 3030 is the default network port for the Ross Licensing Service.

7. In the License Activation Key box, enter the Streamline Play product key obtained from Ross Video Technical 
Support.

8. Click Apply.

9. In the tree view, click Resource.

The Resource web page opens.

10. In the Caprica Service section, use the list to the right of the Active Caprica Service to select Restart.
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Import Caprica Configuration
Streamline Play uses the Caprica Server to communicate with the video server in your Streamline Play system. 
Ross Video Technical Support can supply you with diskset files to configure the Caprica Server to communicate 
with the video server in your Streamline Play system.

 After you load the appropriate diskset for your video server, you must use Dashboard to set the IP address of the 
video server to enable the Caprica Server to connect with the video server.

Load Configurations from a Diskset File
You can load the configurations contained any diskset file listed in the Diskset section of the Diskset web page into 
the Caprica Server.

 Loading a configuration from a diskset file replaces the current configuration of the Caprica Server with the 
configuration contained in the selected diskset file.

To load the configurations from a diskset file on to the Caprica Server

1. Use a web browser to open the Caprica web page URL. The format of the URL is as follows, where
<Caprica Server> is the hostname or IP address of your Caprica Server computer:

https://<Caprica Server>:9090 

The Caprica Login web page opens.

2. Use the following credentials to log in to the Caprica web page:

• User: caprica 
• Password: <your_password> 

3. Click Log In.

The Caprica web page opens.

4. In the tree view, click Diskset.

The Diskset web page opens.

5. In the Diskset section, click the Upload diskset.

The Upload Diskset dialog box opens.
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6. Click Browse.

The File Upload dialog box opens.

7. Locate the diskset files provided to you by Ross Video Technical Support.

8. Select the diskset file that matches your video server and the number of channels on your video server. The 
available diskset files are as follows:

• Caprica-2Channel.tgz — 2 channel Abekas Tria production server
• Caprica-4Channel.tgz — 4 channel Abekas Tria production server
• Caprica-6Channel.tgz — 6 channel Abekas Tria production server
• Caprica-8Channel.tgz — 8 channel Abekas Tria production server
• Caprica-AMP-4Channel.tgz — 4 channel Abekas Tria News playout server

9. Click Open.

The File Upload dialog box closes and the Upload Diskset dialog box displays the name of the selected 
diskset file.

10. In the Upload Diskset dialog box, click Upload.

The Upload Diskset dialog box closes and Caprica adds the selected diskset file to the Diskset section of the 
Diskset web page.

11. In the Diskset section, click the diskset file to load on to the Caprica Server.

A section opens for the selected configuration file.

12. Click Recall.

An Alert opens.

13. Click Recall.

Caprica loads the configuration contained the selected diskset file and automatically restarts to start using the 
new configuration. Click Cancel to cancel loading configurations from the selected configuration file into the 
Caprica Server.

14. To return to the Diskset panel, click Diskset in the breadcrumb menu above the configuration file section.

Set the Video Server Device IP Address
After you load the appropriate diskset for the video server in your Streamline Play system, you must use Dashboard 
to set the IP address of the video server to enable the Caprica Server to connect with the video server.

To set the video server Device IP Address

1. Use one of the following methods to launch DashBoard:

• Double-click the DashBoard icon on the desktop.
• Use the Start menu to select All Programs > DashBoard > DashBoard.

2. In the DashBoard Tree View, expand the Caprica Server node.

3. In the Caprica Server node, expand the Slot 0: Caprica node.

4. Double-click the Port Configuration node.

The Port Configuration client opens in the Device View.
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5. Use the Window menu to select Full Screen.

The Port Configuration client expands to full screen view.

6. In the Port column of the Port Configuration Summary table, double-click REMOTE 1.

The Configure REMOTE 1 panel opens.

7. Click Network Settings.

8. In the Remote IP Address box, enter the IP address of the video server in your Streamline Play system.

9. In the Remote Port box, enter the port number that the video server uses to communicate with external 
applications or devices.

10. Click Apply Changes.

11. Repeat steps 6 to 10 for each device listed in the Port Configuration Summary table.

12. Click Done to close the Configure REMOTE # panel.
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Streamline Server Configuration
This chapter provides configuration instructions for the Streamline Server in your Streamline Play system. The 
following topics are discussed in this chapter:

• License Streamline Server Software
• Configure Caprica Communication Settings
• Configure a MOS Gateway for the NRCS
• Load Templates
• Configure Templates
• Connect RundownControl with the Streamline Server
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License Streamline Server Software
Ross Video uses a product key and feature license keys to control user access to Streamline Server features. The 
Ross Licensing Service verifies the your Streamline Play product key and enables access to the Streamline Server 
features you purchased from Ross Video.

 Before you can license your Streamline Server, your must activate your Streamline Play product key on the Ross 
Licensing Service in your Streamline Play system. Refer to the section “Activate a Product Key for Streamline 
Play Software” on page 3–13 for information on activating Streamline Play product keys.

To license a Streamline Server 

1. Use a web browser to open the Streamline Server Web Administration web page URL. The format of the 
URL is as follows, where <Streamline Server> is the hostname or IP address of your Streamline Server 
computer:

http://<Streamline Server> 

The Streamline Server web page opens.
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2. Click Manage Server.

The Streamline Server - Login web page opens in a web browser window.

3. Enter the following user name and password in the provided boxes:

• Username — streamline 
• Password — <your_password> 

4. Click Login.

The Streamline Server - Main web page opens.

5. Use the Configuration menu to select License.

The License Configuration web page opens.
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6. In the License Settings section, enter the IP address or hostname of your Ross Licensing Service computer in 
the License Server Address box.

7. In the License Server Port box, enter the network port number of Ross Licensing Service.

Port 3030 is the default network port for the Ross Licensing Service.

8. In the Product Key box, enter the Streamline Play product key obtained from Ross Video Technical Support.

9. Click Apply Configuration.

10. Restart your Streamline Play system.

Configure Caprica Communication Settings
The Server Configuration web page enables you to configure the Streamline Server to communicate with the 
Caprica Server in your Streamline Play system.

To configure your Streamline Server to communicate with the Caprica Server

1. In the OverDrive Server web page, use the CONFIGURATION menu to select Server.

The Server Configuration web page opens.

2. In the Switcher Protocol Configuration section, select the Use Caprica Interface check box.

The Caprica Interface Connection section opens.

3. In the Caprica Interface Connection section, enter the IP address of the Caprica Server or Caprica Server 
Cluster in the Host box.

To view the IP address of the Caprica Server, hover your mouse over the Caprica Server node in the 
DashBoard Tree View.

 The default port number 12345 in the Network Port box should not be changed. If you need to change the 
network port number, please contact Ross Video Technical Support. Refer to the section “Contacting Technical 
Support” on page 1–3 for contact details.

4. Click Apply Configuration to save and apply the frame and panel port settings.
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5. Use the TOOLS menu to select System Services.

The System Tools web page opens.

6. In the OverDrive Services Management section, click Restart.

Caprica is connected to your Streamline Server when the Switcher LED icon at the top of the OverDrive 
Server Web Administration web page turns green.

Configure a MOS Gateway for the NRCS
To enable Streamline Server to connect with the NRCS in your Streamline Play system, you need to configure a 
MOS Gateway for the NRCS.

To configure MOS Gateway settings for an NRCS:

1. Use the Configuration menu to select Gateway.

The MOS Gateway Configurations page opens, listing the MOS Gateways on an OverDrive system.
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2. In the NRCS Configuration section of the MOS Gateway Configurations page, click Edit to the right of the 
Default MOS Gateway.

The Edit NRCS section opens.

3. Use the Newsroom System list to select the NRCS to use in the your production environment.

4. Select the Enable MOS command control in gateway check box to add the Command section to the 
Rundown Info tab. Clear this check box to hide the Command section in the Rundown Info tab. This check 
box is cleared by default.

You can use the Command section to monitor MOS Messages and troubleshoot communications between the 
NRCS and OverDrive.

5. Verify that the Send MOS Heartbeats to NCS check box is selected to send heartbeat data to the NRCS 
selected from the Newsroom System list. The NRCS uses heartbeat information to verify network and 
gateway continuity.

 You should only clear the Send MOS Heartbeats to NCS check box under the direction of Ross Video 
Technical Support when troubleshooting connectivity issues between your NRCS and OverDrive.

6. Configure QNews v1.5 or QNews specific settings. The following setting is only available when you select 
QNews v1.5 or QNews from the Newsroom System list:

• Remove Rundown when MOS server stops exporting — select this check box to make the MOS Gateway 
remove the NRCS rundown when it receives a remove message from the MOS Server. This option is 
selected by default.

7. In the Primary section, enter the ID that OverDrive uses to access the NRCS n the NRCS ID box. Refer to the 
NRCS client for the correct NRCS ID.

8. In the NRCS MOS Server Host Address box, enter the hostname or IP address of the NRCS server computer.

The NewStar NRCS does not require this setting. 

9. In the OD GW Host Address box, enter the host name or IP address of the computer running the primary 
MOS Gateway.

10. In the OD MOS ID box, enter the MOS ID assigned to the OverDrive Primary system by the NRCS.

11. In the MOS Low Port box, confirm the default value of 10540.

Changing the port number of the MOS Low Port setting stops all running services and disconnects all clients 
from the MOS Gateway. Ross Video recommends using the default port number unless otherwise specified.

12. In the MOS High Port box, confirm the default value of 10541.

Changing the port number of the MOS High Port setting stops all running services and disconnects all clients 
from the MOS Gateway. Ross Video recommends using the default port number unless otherwise specified.
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13. When your OverDrive system contains a Redundant MOS Gateway, use the Redundant section, 
Redundant/Buddy for ENPS, to configure the following settings for the Redundant MOS Gateway:

a. For the ENPS NRCS, enter the NRCS ID for the ENPS Buddy MOS Server in the NRCS ID box.

b. In the NRCS MOS Server Host Address box, enter the hostname or IP address of the Redundant NRCS 
server computer. For the ENPS NRCS, enter in this box the hostname or IP address of the ENPS Buddy 
Server.

The NewStar NRCS does not require this setting. 

c. In the OD GW Host Address box, enter the host name or IP address of the computer running the 
Redundant MOS Gateway.

d. In the OD MOS ID box, enter the MOS ID assigned to the OverDrive Redundant system by the NRCS.

e. In the MOS Low Port box, confirm the default value of 10540.

Changing the port number of the MOS Low Port setting stops all running services and disconnects all 
clients from the Redundant MOS Gateway. Ross Video recommends using the default port number unless 
otherwise specified.

f. In the MOS High Port box, confirm the default value of 10541.

Changing the port number of the MOS High Port setting stops all running services and disconnects all 
clients from the Redundant MOS Gateway. Ross Video recommends using the default port number unless 
otherwise specified.

14. Click Save.

OverDrive saves the MOS Gateway settings and the Edit NRCS section closes.

15. Use the TOOLS menu to select System Services.

The System Tools web page opens.

16. In the OverDrive Services Management section, click Restart Mos Gateway.

Load Templates
The Sequencer uses Master and Device templates to playout assets from the video server in the Streamline Play 
system. Ross Video Technical Support can supply you with backup files (.odv5) to load Master and Device 
templates for the video server in your Streamline Play system.

 You must load templates before you license the Streamline Server.

To load templates for the Abekas video server in your Streamline Play system

1. Close the Streamline Server, Streamline MOS Gateway, and Sequencer.

2. Use one of the following methods to start RapidRestore:

• On the desktop, double-click the RapidRestore icon.
• Use the Start menu to select All Programs > OverDrive > RapidRestore.

The OverDrive RapidRestore window opens.
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3. Click Restore Backup.

The Select File screen opens.

4. Click Browse to select the backup file from which to restore OverDrive settings and rundowns.

The Open dialog box opens.

5. Locate the diskset files provided to you by Ross Video Technical Support.

6. Select the backup file that matches your video server and the number of channels on your video server. The 
available backup files are as follows:

• Streamline-2Channel.ovd5 — 2 channel Abekas video server
• Streamline-4Channel.ovd5 — 4 channel Abekas video server
• Streamline-6Channel.ovd5 — 6 channel Abekas video server
• Streamline-8Channel.ovd5 — 8 channel Abekas video server

RapidRestore enters the name of the selected file in the File Name box.

7. Click Open.

The Open dialog box closes and RapidRestore enters the full path to the selected backup file in the File Name 
box on the Select File screen.

8. In the Select File screen, click Next.

The Select Packages screen opens, listing the OverDrive clients that have packages that can be restored from 
the selected backup file.

9. Use the Package list on the left to select the RundownControl package.
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10. Click Add Package.

RapidRestore adds the RundownControl package to the Restore list on the right.

11. Add the Server and Template Editor packages to the Restore list.

12. Click Finish.

The Checking Prerequisites screen opens.

13. Click Next.

The Restoring Backup screen displays the restore progress. When the restore completes, the Restore 
Complete alert opens.

14. Click OK.

The alert closes, and the Restoring Backup screen displays the results of the restore.

15. Click Close.

The OverDrive Restore Wizard closes.

16. In OverDrive RapidRestore window, click Close to exit RapidRestore.

Configure Templates
Each Device template requires a MOS ID and each MOS ID requires an association with a default template. The 
Template Editor enable you to edit the MOS ID settings for Device templates.

Set the Template Editor Network Connection
Before you can use the Template Editor to edit templates, you must configure the Template Editor to connect to the 
Streamline Server in your Streamline Play system.
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To configure network connection properties for TemplateEditor:

1. Use one of the following methods to start TemplateEditor:

• On the desktop, double-click the TemplateEditor icon.
• Use the Start menu to select All Programs > OverDrive > TemplateEditor.

TemplateEditor opens.

2. Use the Tools menu to select Network Setup.

The Network Setup dialog box opens.

3. In the Networks Settings section, enter the IP address or hostname of the Streamline Server in the Primary 
Server box.

4. Click Test Host Connection.

The Template Editor tests the connection to the set Primary Server, and reports one of the following results:

• Succeeded — TemplateEditor is connected to the set Primary Server.
• Failed — TemplateEditor could not connect to the set Primary Server.

5. Click OK to save connection properties and close the Network Setup dialog box.

The Server status LED icon in TemplateEditor dialog box turns green when TemplateEditor connects to the 
selected OverDrive Server.
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Set Device Template MOS ID
For each video server Device template defined for your Streamline Play system you have to set the MOS ID for the 
video server.

To set the MOS ID for a video server Device template

1. In the TemplateEditor, click the Devices tab.

The Devices tab opens.

2. Use the Devices list to select a video server Device template to edit.

3. Click Edit.

The Editing Device dialog box opens.

4. In the Video Server Properties section, enter the MOS ID of your Abekas video server in the MOS ID box.

5. Click Save to save the MOS ID set for the video server.

The Editing Device dialog box closes.

6. For each video server Device template in the Devices tab Devices list, repeat steps 2 to 5 to set the MOS ID.
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Select the Default MOS Template of a Device
The TemplateEditor does not automatically create a Master Template for MOS Video Server devices. For each 
video server Device template defined for your Streamline Play system you have to select a Master Template for the 
video server.

To select a Master Template for a MOS video server Device template

1. In the TemplateEditor, use the Tools menu to select Configure MOS Video Server Templates.

The Configure MOS Video Server Templates dialog box opens.

2. In the MOS Video Server Type column, select the type of MOS Video Server device for which you want to 
select a default Master Template.

3. Click Browse.

The Template Selection dialog box opens displaying the Master Templates that use the selected type of MOS 
Video Server device in at least one ME.

4. Select the Master Template to use as the default Master Template for the selected type of MOS Video Server 
device.

You can only select one Master Template as the default Master Template for a type of MOS Video Server 
device.

5. Click the OK.

The Template Selection dialog box closes. The Master Template column in the Configure MOS Video 
Server Templates dialog box displays the name of the Master Template selected for a MOS Video Server 
type.
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6. For each video server Device template listed in the Configure MOS Video Server Templates dialog box, 
repeat steps 2 to 5 to set the MOS ID.

7. To change the default Master Template used by a selected MOS Video Server type, click Browse.

8. To remove the default Master Template used by a selected MOS Video Server type, click Clear.

9. Click OK to save the your MOS Video Server type default Master Template settings and close the Configure 
MOS Video Server Templates dialog box.

10. In the TemplateEditor, use the File menu to select Exit.

The TemplateEditor closes.

11. Restart the Streamline Play system computer.

Connect RundownControl with the Streamline Server
Before you can use an instance of RundownControl to open and work with NRCS rundowns, you must set the IP 
address of the Streamline Server for the instance.

To connect RundownControl with the Streamline Server

1. On the desktop, double-click the Rundown Control icon.

When RundownControl contains user profiles in addition to the overdrive (Default User) user profile, the 
Select User dialog box opens. For RundownControl systems that only contain the overdrive (Default User) 
user profile, skip to the results of step 3.

To work without a user profile during a RundownControl session, do the following:

a. Click the Select User dialog box Windows Close button.

b. Skip to the results of step 3.

2. From the User list, select the user profile to work with for the RundownControl session.

The selected user profile defines the following preferences for the RundownControl session:

• Custom perspective layout
• Hot key assignments
• Timer settings
• Custom Control button assignments
• Rundown table column layout
• Setting on the Rundown Settings, GPI, and NRCS Settings tabs in RundownControl Options dialog box.

Any preference changes made during an RundownControl session are saved with the selected user profile.
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3. Click Select User.

For users that have a password, the Enter Password dialog box opens.

To enter a user password, follow these additional steps:

a. In the Enter Password box, enter the password for the selected user profile.

b. Click OK.

RundownControl opens using the user preferences from the selected user profile, displayed in the 
RundownControl title bar.

4. Use the Tools menu to select Options.

The Options dialog box opens.

5. Click the Network Settings tab.

The Network Settings tab opens.

6. In the Networks Settings section, enter the IP address or hostname of the Streamline Server in the Primary 
Server box.

7. Click Test Host Connection.

OverDrive tests the connection between RundownControl and the set Primary Server, and reports one of the 
following results:

• Succeeded — RundownControl is connected to the set Primary Server.
• Failed — RundownControl could not connect to the set Primary Server.

8. Click OK to save changes and close the Options dialog box.

The Server status LED icon turns green when RundownControl connects to the selected Streamline Server.

9. In Rundown Control, use the File menu to select Exit.

The Exit dialog box opens.

10. Click Yes to exit RundownControl.

RundownControl closes.
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Streamline Configuration
This chapter provides configuration instructions for the Streamline Server in your Streamline Play system. The 
following topics are discussed in this chapter:

• Activate a Streamline Product Key
• Connect Streamline with the NCS
• Add File System for an Abekas Video Server
• Set Your Abekas File Storage Method as the Default Target
• Set the Streamline Service User
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Activate a Streamline Product Key
Ross Video uses product keys to manage user licenses for Streamline features. You can obtain a Streamline product 
key from Ross Video Technical Support.

When you activate a Streamline product key, your Streamline Server computer must contact the Ross Video 
Activation Server through the internet.

To activate a Streamline product key

1. Verify that the Streamline computer can connect to the Internet.

2. Use one of the following supported web browsers to open the Streamline web page URL:

• Microsoft Internet Explorer® version 9 or greater
• Mozilla Firefox® version 3.6 or greater
• Google Chrome™ browser version 17.x or higher
• Apple Safari® version 5.1.x or greater

An Alert dialog box opens with the Ross Streamline web page.

 If the Ross Streamline web page does not open, contact Ross Video Technical Support.

3. In the Alert dialog box, click OK.

The Alert dialog box closes.

4. In the Streamline Login dialog box, enter the following user name and password in the provided boxes:

• Username — root 
• Password — <your_password> 

5. Click Login.

You are logged into the Streamline Server as an administrator.

 If a message displays indicating that the system is in maintenance mode, Streamline cannot communicate with 
the database. Contact Ross Video Technical Support.

6. In the Tools section of the main toolbar, click the  Configuration icon.

The Configuration panel opens.
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7. Click the Licensing tab.

The Licensing Configuration tab opens.

8. Obtain a Streamline product key from Ross Video Technical Support.

9. In the Product Key box, enter the product key obtained from Ross Video Technical Support.

10. Click Activate.

After activating the entered product key, an Alert dialog box opens requesting a web browser window refresh.

11. Click OK

The Alert dialog box closes and the Licensing Configuration tab updates to display the new feature licenses 
associated with the activated product key. The Status column displays one of the following states:

12. Click OK.

The Configuration dialog box closes.

13. Refresh your web browser window.

Streamline add icons to the toolbar for the newly activated features, making the features accessible to 
Streamline users.

Background Status Description

 Green Active The feature is active and available to Streamline users.

 Yellow Expires in # days The feature availability for Streamline users expires in the displayed 
number of days.

 Red Expired The feature has expired and is no longer available to Streamline 
users.

 Red Invalid MAC The feature license key is invalid for the active network interface 
card of the Streamline computer.

 White Not Purchased The feature is not accessible to Streamline users, but it is available 
for purchase.
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Connect Streamline with the NCS
The Streamline Play system uses the MOS protocol to connect the Streamline Server with the system NCS.

To configure an uplink between a Streamline Server and an NCS

1. Log in to your Streamline Server as an administrator.

2. On the main toolbar, click the  Configuration icon.

The Configuration window opens.

3. On the Configuration window toolbar, click the  MOS icon. If the MOS icon is not visible, you are not an 
administrator and cannot configure MOS connections.

The MOS panel opens.

4. In the MOS ID box, enter a MOS ID for your Streamline Server to uniquely identify the server as a MOS 
device.

5. Record the MOS ID that you set for your Streamline Server.

6. Select the Enable NCS Uplink check box to establish a connection between the Streamline Server and the 
NCS specified in the NCS ID and NCS Host boxes.

7. In the NCS ID box, enter the NCS ID of your NCS.

8. In the NCS Host box, enter the hostname or IP address of the NCS gateway.

9. Click OK.



Streamline Play Configuration Guide (v23.5) Streamline Configuration • 6–5

Add File System for an Abekas Video Server
Streamline uses files systems to store the media files ingested into Streamline through a file storage method. The 
file system that you add for your Abekas video server will store the ingested media files associated with the assets 
that Streamline pushes to your Abekas video server.

After you define your Abekas video server file system, use the File Storage tab to associate your file system with a 
file storage method. Streamline users can use the associated file storage method to ingest media files into 
Streamline and store them in your file system.

To add a file system for an Abekas video server

1. On the Configuration window toolbar, click the  System icon.

The System panel opens.

2. Click the File Systems tab.

The File Systems tab opens.

3. Click Add.

The Create File System settings open.

4. Use the Provider list to select Abekas as the type of file system to add.

5. Click Next.

The Create Abekas File System settings page opens.

6. In the Namespace box, enter the name that Streamline uses to access the file system.

Once you create a file system, you cannot change the Namespace set for the file system.

7. In the Name box, enter a name for the file system.

8. In the Root box, enter the directory path for the root directory of the Abekas video folder.

9. In the Host box, enter the hostname or IP address of the Abekas video server.

10. In the Port box, enter the port number that the Abekas video server uses to communicate with your Streamline 
Server.

11. Click Create.

Streamline adds the new file system to the File Systems list.
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Create a File Storage Method for an Abekas Video Server
Streamline uses file storage methods to ingest media files and store them in an associated file system. The file 
storage method that you create for your Abekas video server will ingest media files into the file system your added 
to Streamline for your Abekas video server.

To create a file storage method for an Abekas video server

1. On the Configuration window toolbar, click the  Asset icon.

The Asset panel opens.

2. Click the File Storage tab.

The File Storage tab opens.

3. Click Create.

The Preset page opens.

4. Use the Type list to select Abekas as the type of file storage method to create.

5. Click Next.

The Setup page opens. The Steps list displays your progress through the new file storage method creation 
procedure. You can also use the Steps list to revisit completed steps in the procedure.

 An asterisk (*) identifies the required settings for which you must enter a value before continuing on with the 
next step in creating a new file storage method.

6. In the Name box, enter a name for the file storage method.

7. In the Key Name box, enter the name to use as the identifier for the file storage method. When you click in this 
box, Streamline enters a suggested Key Name that you can edit.

 You cannot change the Key Name of a file storage method after you save the file storage method.

8. Use the File System list to select the Streamline file system in which to save media files that Streamline users 
ingest using the file storage method.

 You cannot change the file system associated with a file storage method after you save the file storage method.

The File System list only contains the file systems available on your Streamline Server. You can use the File 
Systems tab to view, add, and manage the a file systems on your Streamline Server.
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9. Use the Icon list to select an icon to identify the file storage method.

If the icons in the list are not appropriate for the file storage method, do the following:

a. Use the Icon list to select Upload an Icon.

Inception displays a Browse button.

b. Click Browse.

The File Upload dialog box opens.

c. Use the File Upload dialog box to select the image file to use as the icon for the file storage method.

d. Click Open.

Streamline adds the image contained in the selected image file to the Icon list as the Uploaded Icon option, 
and automatically selects the uploaded image as the icon for the file storage method. You can only upload 
one image to the Icon list at a time. Uploading another image to the Icon list replaces the current uploaded 
image with the new image.

10. Click Next.

The Naming Rules page opens.

11. Click Next.

The Pathing Rules page opens.

12. Click Next.

The Ingest Validations page opens.

13. Click Next.

The Ingest Triggers page opens.

14. Click Next.

The Auto-Purge Rules page opens.

15. Click Finished.

The Auto-Purge Rules page closes and Streamline adds the new file storage method to the File Storage table in 
the File Storage tab.

Set Your Abekas File Storage Method as the Default Target
After you create a file storage method for your Abekas video server, you must set your Abekas files storage method 
as the default file storage method to automatically push ingested media files to devices; such as, video servers for 
playout.

To set the default target

1. On the Configuration window toolbar, click the  Asset icon.

The Asset panel opens.

2. Click the Asset Configuration tab.
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The Asset Configuration tab opens.

3. Use the Default Target list to select the file storage method that you created for your Abekas video server.

4. Click OK to save settings and close the Configuration panel.

Set the Streamline Service User
You must also set the set the Streamline service to run as the Streamline user.

To set the user that runs the Streamline service

1. Log in to the Streamline Play computer using the following credentials:

User Name: streamline 

Password: <your_password> 

2. From the Windows Desktop, press Windows Key+R.

The Run dialog box opens.

3. In the Open box, type the following application name:

services.msc 

4. Click OK.

The Services window opens.
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5. In the Services list, locate the Ross Streamline service.

6. Right-click the Ross Streamline service and select Properties from the shortcut menu.

The Ross Streamline Properties dialog box opens.

7. Click the Log On tab.

The Log On tab opens.

8. Select the This account option.

9. In the This account box, enter streamline.

10. In the Password box, enter <your_password>.

11. In the Confirm Password box, enter streamline.

• Click OK.

A Services alert dialog box opens.

12. Click OK.

A second Services alert dialog box opens.

13. Click OK.

The Ross Streamline Properties dialog box closes.

14. In the Services window, use the File menu to select Exit.

The Services window closes.
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Inception Configuration
When you use Inception as the NRCS in your Streamline Play system, you must configure Inception MOS devices 
for the Streamline Play. This chapter provides instructions on how to create MOS devices in Inception. The 
following topics are discussed in this chapter:

• Create the Streamline Play Edition MOS Device
• Create the Streamline Play MOS Device
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Create the Streamline Play Edition MOS Device
The Streamline Play Edition MOS device enables Inception to communicate with the Streamline component in your 
Streamline Play system.

To add a the Streamline Play Edition MOS device to Inception

1. In a one of the following supported web browsers, navigate to the Inception web page.

• Microsoft Internet Explorer® version 9 or greater
• Mozilla Firefox® version 3.6 or greater
• Google Chrome™ browser version 17.x or higher
• Apple Safari® version 5.1.x or greater

The Login panel opens.

2. In the Login panel, enter your system administrator login credentials in the Username and Password boxes.

The default system administrator login credentials are as follows:

• Username — root 
• Password — <your_password> 

3. Click Login.

Inception opens.

When Inception displays a message indicating that the system is in maintenance mode, a system administrator 
must establish a database connection before you can log in to your Inception Server.

4. On the main toolbar, click the  Configuration icon. If the Configuration icon is not visible, you are not an 
administrator and cannot configure the server.

The Configuration window opens.

5. On the Configuration window toolbar, click the  MOS icon.

The MOS panel opens.

6. Click the Devices tab. If the Devices tab is not visible, you do not have an NCS license for your Inception 
Server and you cannot add MOS devices to your the server.

The Devices tab opens.
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7. Click Add.

The Create MOS Device page opens and displays the Device Settings section for the new MOS device.

8. Use the Device list to select Ross Streamline.

9. In the MOS ID box, enter the MOS ID of the Streamline component in your Streamline Play system.

10. In the Host box, enter the hostname or IP address of the Streamline component in your Streamline Play system.

11. In the Name box, enter Streamline Play Edition.

12. Click Next.

The next page opens and displays the MOS Plugin section for the new MOS device.

13. Click Next.

The next page opens and displays the Appearance and the MOS Settings sections for the new MOS device.

14. Use the Icon list to select an icon for the Streamline Play Edition MOS device.

15. Click Save.

Inception adds the Streamline Play Edition MOS device to the MOS Devices list.

Create the Streamline Play MOS Device
The Streamline Play Edition MOS device enables Inception to communicate with the Streamline Server component 
in your Streamline Play system.

To add a the Streamline Play Edition MOS device to Inception

1. In the Devices tab of the Configuration window, click Add.

The Create MOS Device page opens and displays the Device Settings section for the new MOS device.

2. Use the Device list to select Uncertified Device.

3. In the MOS ID box, enter the MOS ID of the Streamline Server component in your Streamline Play system.

4. In the Host box, enter the hostname or IP address of the Streamline Server component in your Streamline Play 
system.

5. Use the MOS Version list to select 2.8.4.

6. In the Name box, enter Streamline Play.

7. Select the Enabled check box.

8. Click Next.

The next page opens and displays the MOS Plugin section for the new MOS device.

9. Use the Plugin list to select None.

10. Click Next.

The next page opens and displays the Appearance and the MOS Settings sections for the new MOS device.

11. Use the Icon list to select an icon for the Streamline Play MOS device.

12. Select the Enable Story Send check box.

13. Clear the Enable Placeholders check box.

14. Clear the Enable Timing Control check box.

15. Click Save.

Inception adds the Streamline Play MOS device to the MOS Devices list.
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Abekas Video Server 
Configuration
This chapter provides configuration instructions for the Abekas video server in your Streamline Play system. The 
following topics are discussed in this chapter:

• Set Up a Watch Folder on the Abekas Video Server
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Set Up a Watch Folder on the Abekas Video Server
A watch folder on the Abekas video server stores the media items that Streamline pushes to the video server. The 
Abekas video server can ingest media items from the watch folder for playout. Settings for the watch folder on the 
Abekas video server are as follows:

• Name — H:\watch 
• Share with User — streamline. The streamline users must be a local user with the same password as per the 

host Streamline user account.
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